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Successful Internet Strategies Books 

PROFESSIONAL ONLINE 
NEWSLETTERS & EMAILS 
 
A native New Yorker, Debbie Mayo-Smith is Managing Director of Successful Internet 
Strategies www.successis.co.nz 
 
 
After earning a Double Honours Bachelor of Science Degree in Economics and 
Geography from Southern Connecticut University in Hartford Connecticut USA, Debbie 
worked as a Market Analyst on Wall Street. 
Debbie moved to NZ in the mid-80�s, Tower Trust Services created their first Marketing 
Manager position for her, and Debbie later left to help found Jardine Fleming NZ as 
Director of Marketing. 
 
 
Always innovative, Debbie was one of the first marketers to capture the usefulness of 
email for communication early in 1999. Since then Debbie�s reputation has grown to a 
world class leading Internet marketing expert and business strategist. Debbie�s specialty 
is how "every-day" business people can easily, practically and with great success improve 
their performance and business results. 
 
 
Today Debbie has an exceedingly busy practice in the Asia Pacific region as an 
International Keynote Speaker, Author and Workshop Presenter. 
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SECTION 1 
 
 
Preparation: Your Background 
Knowledge 
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CHAPTER 1 
 
THREE TYPES OF EMAIL YOU CAN SEND 
 
1. Plain text 
2. Simple html � (Rich Text) simple formatting 
3. Advanced html � complex formatting with tables and forms and graphics 
 
1. Plain Text. 
 
Plain text is just that. Very, very plain text. 
 
This is the only way to be technically sure that every single email will be 
legible to the reader, and get through. 
 
Some people, companies or government departments block HTML 
(definition on page 13) for security or space reasons. A few others have 
operating systems too old to see it, Office 95 for example. You must have 
a plain text option available. 
 
Think Of Yourself Using An Old Fashioned Typewriter. 
Only one font (Courier) only one size (10pt). No bold, no underlining, no italics, no 
bullet points or auto numbering and certainly no tables (ways 
to format so your text looks like it�s set in columns. More on tables later). 
There are three ways to make your plain text newsletter templates more 
interesting and of course, easier to read: 
 
1. Using different symbols for graphic design. 
2. Skipping lines to give white space. 
3. Putting important text in all capital letters. 
 
You can design your plain text template straight in your email software 
(professionals call this your email client). This is for example Outlook, 
Outlook Express, Netscape, Lotus Notes, etc. Or use notepad or Microsoft 
Word. However in Word be sure to save it as a plain text document. Do 
not do your plain text template in Dreamweaver or FrontPage as they will 
automatically generate HTML code for it and it doesn�t work well. 
 
We suggest doing it straight in Outlook/Outlook Express or notepad. 
 
For plain text, like its fancier sibling HTML, your template goal is to allow 
your content to be easy to read � i.e. easily skimmable. 
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Remember, plain text is simply 10 point Courier typeface. Your design 
alternatives are: 
 
� Capital letters 
� White space 
� Symbols 
That�s it. 
 
Figure1.1 Cool example of the use of Symbols to graphic effect. 
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Figure 1.2 Example of manually created numbered lists and lines to separate articles 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
To get a plain text look that you like, the simplest thing to do is have a 
play typing a few symbols together and repeat them to form a pattern. 
You also don�t want to have your text going in too wide of a column. It�s 
too hard to read that way. What you do is wrap your text at about 65 
characters across. You do this by hitting shift and enter at the same time 
for each line. Having said that, Outlook XP and 2003 remove extra line 
breaks so it wreaks havoc on this manual formatting. You can also do a 
hard return (just hitting enter) at the end of each line. 
 
Be sure to get your counting right when doing those returns! If not your 
end result is horrible with some lines being only a few words. Test it by 
sending the email to yourself. 
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Some Norms Being Used Now Are: 
 
1. Headlines, titles i.e. the important information in all capital letters. But 
only the important text � you don�t want to confuse people or have the 
text "Screaming" at them by having body text in all caps. 
 
2. Create bullet pointed lists using a symbol or two � such as two 
asterisks put together. 
 
3. Type numbers and a space or two to create numbered lists. 
 
4. Skipping lines between subtitles or different articles to create white 
space for skimming and helping your readers to differentiate between 
your articles. 
 
5. Putting a dashed line (lots of minus signs strung together) or other 
symbol combination in between articles. 
 
6. Centering information by hitting the space bar (remember there�s no 
formatting so tab doesn�t work). 
 
7. Leaving white space for visual appeal and easy reading. 
 

Copyright©2004 Successful Internet Strategies  Debbie Mayo-Smith debbie@successis.co.nz   
Buy the full version now http://www.successis.co.nz/order.htm  



Professional Online Newsletters and Emails  Exactly How To Create Your Own 
Copyright © 2004 Debbie Mayo-Smith - Successful Internet Strategies   

 

Copyright©2004 Successful Internet Strategies  Debbie Mayo-Smith debbie@successis.co.nz

Figure 1.3 A great plain text example in my opinion 
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! VIP Technical Tip 
By the way, I promise this tip will make much more sense when you read the 
entire book, then come back to it. 
 
Want to know a great "cheating" way to do the plain text version of your 
HTML one? 

1. Design your Advanced HTML (page 16) email in Dreamweaver, 
FrontPage or similar software. 
 
2. Preview it. Hit F12 in Dreamweaver, Select the Preview pane in FrontPage. 
 
3. Hit Control + A (select everything). Then Control + C to copy 
a. Open Outlook/Outlook Express or your email client. 
b. Hit Control + V (paste). 
 
4. Now you�ve got your HTML as an email. Select on the 
Toolbar>Format>Plain text. 
 
5. It will say "Are you sure". You say "Yes, of course I�m sure". Select Yes. 
 
6. Voila! Gone are your columns, colours, graphics, formatting. Now you just 
have to start your plain text formatting. You�re already three quarters of the 
way there!!! 

 
Simple (RTF) And Complex Html 
 
First To Define Html 
HTML stands for Hypertext Markup Language. It�s simply formatting 
instructions put in markers, called tags. Don�t be afraid. The Html coding 
is simply the email (or webpage) talking to your computer saying "make 
this text blue, end the paragraph here, put a graphic from this webserver 
right here; make this text bold and right align it. 
 
Do you catch my drift? When you understand it, it really is quite simple. 
 
Microsoft FrontPage and Macromedia Dreamweaver are examples of 
WYSIWYG design tools (what you see is what you get) that create the 
HTML code for you automatically. 
 
Here, let me walk you through a bit of how to look at and understand 
HTML code. 
 
What you see "on the stage" so to speak, on the next page, is the name Debbie 
in capitals, bold, black colour and on the left side of the page all by itself. 
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DEBBIE 
The actual html code "behind the curtains" would be 
<p><p align="left"><b><font face="Trebuchet MS" size="5" 
colour="#000000">DEBBIE</font></b></p> 
<p> start a new paragraph. 
<p align="left"> put text to the left. 
<b> everything from this point on is Bolded. 
<font face="Trebuchet MS" size="5" color="#FF0000"> make 
the font Trebuchet make it 16 point and make it black. Apply all this to 
the following text DEBBIE. 
</font> end the font. 
</b> end the bold. 
</p> end the paragraph. 
 
With great programs like Dreamweaver and FrontPage, there is no 
need to know how to write this code, but it is useful to understand a little 
about how it works. The HTML code is what you will paste into your 
personalisation software (don�t worry � it�s easy we promise!!) 
 
2. Simple Html � Simple Formatting 
Simple html is just that. Your email can have simple formatting with it. 
This would include the ability to change your font, its size, colour or 
orientation (left, centre and right aligned). The ability to have bullet points 
or numbered lists. 
 
Are you thinking "Debbie is what you�re calling Simple HTML actually 
Rich Text?" Yup. You�re right. But Rich Text Format (RTF) is a Microsoft 
format term and I wanted to speak more generally. 
 
 
Figure 1.4 Caveat: When sending an email out via Outlook/Express � whether straight 
or via a Word email merge this is the only formatting you can safely do. Meaning you�re 
sure others will see exactly what you send. Do Not paste tables, columns, graphics etc 
into Outlook 
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Simple HTML emails are great for using with a Microsoft XP and 2003 
personalised email merge (detailed in Appendix A), or doing straight out 
of Outlook / Outlook Express � One by one or BCC Blind Carbon Copy. 
 
Figure 1.5 To turn on your HTML option in Outlook/Express, go to Tools>Options>Mail>Format
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Figure 1.6 This is a good example of using simple HTML with formatted text and 
bullet points. 
 
 
 
 
 
 
 
 

! VIP Danger Alert - Graphics 
Many people insert company logos or graphics directly into their everyday 
emails. Beware, only your recipients that are on Microsoft 2000 or above and 
HTML and graphic enabled will receive the email with that "graphic" where it 
should be � where you inserted it in your email. All the rest will see the email 
text only and have the graphic clipped on as an attachment, or have to open 
it with Internet Explorer - or not see it at all. Note: We will cover inserting 
graphics in emails in Chapter 8. 

# VIP Marketing Smarts Tip 
For every day emails, or ones you send directly through your email software 
(Outlook/E, Lotus, Act etc) do you really need to have your logo or graphic in 
that email? After all the logo is only important to you, not them. And if it will 
impede your message � why do it? 
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3. Complex Html � Advanced Formatting With Tables, 
Forms And Graphics 
You know those emails you get in that look like web pages? They�re 
colourful. They have images. They could have built-in forms that you 
answer. Text looks like it�s in columns. This is what I call advanced html. 
It�s the next step up, simple to do once you know how � and the tricks. 
This is the main focus of this book � we�ll show you how you can do an 
email or newsletter template like these below. 
 
 
Figure 1.7 A  great example of an advanced HTML email. 

 

 
! VIP Danger Alert - What Do I Use? 
Sometimes large corporations and government departments would have I.T. 
Managers mandating that they only allow plain text emails to come in. Why? 
Viruses and weight. Colourful (HTML � described just before) emails are 
"heavier". The additional formatting of colour, tables, graphic links, fonts etc 
make the email carry more information behind the scenes (you don�t see the 
coding) so it weighs more in kilobytes. So when they have to deal with 
hundreds of thousands of messages, some of them just say we�re not going 
to let HTML in to save server space. Also viruses are sometimes hidden in the 
HTML coding. None of us would ever do that right? Right! 
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# VIP Marketing Smarts Tip 
Note if someone sends you a plain text email, it does not mean they cannot 
receive the colourful ones. It could simply be their computer outgoing email 
setting, or their preferred option of sending. 
You�ll get much higher response with HTML. It�s easier to read and scan. 

# VIP Marketing Smarts Tip 
Microsoft has built in sniffer technology that will convert a simple html email to 
plain text when the recipient requires it. This occurs when the email is sent 
through Outlook, Outlook Express, or a Word email merge. 

! VIP Danger Alert 
If you�re going to do your newsletter in Outlook with simple formatting, send 
the email to yourself. Hit forward and change the format to plain text. See how 
it looks now. 
Why? If you�ve incorporated bullet points or lists, titles or paragraphs and the 
like, you�ll want to see how it looks with all the formatting stripped out 
(remember that�s the root of plain text � typewriter). 
There might be a few small changes you�ll want to make to your original so the 
end plain text result comes out better. 
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SECTION 2 
Software You�ll Need To Do It Well 
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CHAPTER 2 
DATABASES 
Don�t you dare say what database! I won�t go into a whole spiel here, but 
a marketing database can be one of the most valuable assets of your 
business. A veritable goldmine when you work it � cleverly and in a 
targeted fashion. 
 
You�ve got to have your list all together in one place of course. While 
many of the email merging software packages you buy will accept a 
variety of databases (Excel, Access, FoxPro, FileMaker Pro, Outlook 
Address Books and Contacts, Lotus Notes, ACT and the like) the 
universal database conversation is conducted in �text� as a CSV or a TAB 
file. These files are text based with the information separated by tabs or 
commas. All the above database programs can have files saved in 
CSV/TAB form. 
 
If you�re not already an enormous fan of Microsoft Excel, you should be. 
I�m in love with it as it�s one of my best work mates. I use Excel as my 
workhorse to manipulate all the database work I do before emailing. 
 
If you don�t have it already, you might want to purchase my Superb Tips 
and Tricks for Managing Your Customer Information if you have any 
database work to do at all. It could save you literally hours and hours and 
hours of manual work by showing you the magical secrets of 
manipulating database information in Excel. It�s marvelous whether you 
are starting from scratch and want to build a marketing database or if you 
want to fix your existing one up. Order it on www.successis.co.nz. 
 
We�ll explain all about personalisation software in Chapter Ten. But let me 
say here while we�re talking about databases that with personalisation � 
you can merge into an email any field you have in your database. So you 
might want to consider moving your email list from Contacts or an 
address book to Excel, Access, etc where you can store much more 
information and thus have greater freedom in personalisation than just 
name and email address. The sky�s the limit really � personalisation 
allows you to do invoicing, receipts, even having a head office send out 
personalised emails from each sales representative to their clients with a 
single push of a button. If it�s in the database � you can merge it!!! 
 
The minimum database I think you should use is something similar to 
Outlook Contacts. Outlook Express isn�t enough because the address 
book can only hold "address" information, and not categorise your 
contacts in any manner. And in emailing today, targeting the right 
information to the right person is paramount. At Successful Internet Strategies, we do at 
least 2-4 versions of our monthly newsletter, targeting the right articles to the right 
geographical audience. 
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So if we mention a Sydney workshop in the newsletter, only the 
individuals in the drivable area around Sydney will receive that version. 
Why burn your permission or people�s value of your newsletter by 
advising them of something they�re not going to be interested? 
 
In Outlook 2003 Business Contact Manager (and of course in Outlook 
Contacts) you can assign each "contact" a category. Then sort by category. 
 
Here�s a superb tip. 

! VIP Technical Tip 
Sort your contacts by category in Outlook. Highlight the category contacts you 
want, copy them. Open Excel, put your mouse in the very first cell � A1 and 
paste. You have got a targeted database ready to manipulate /or email to 
directly! 
 
Figure 2.1 Business Contact Manager (Outlook 2003) or Outlook Contacts allow you 
to assign categories to contacts, then to sort your contacts by the categories 
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What Outlook Contacts or Business Contact Manager does not have and 
Excel does, is the fabulous ability to allow you to create any user defined 
field. Then to manipulate that data, separating, merging, fixing, cleaning. 
User defined field means you create your own field of information - for 
example your services, where customers heard of you, if they require 
plain text or the HTML emails. The sky is the limit. For more advice, refer 
to Super Tips and Tricks for Managing Your Custom Information. 

! VIP Technical Tip 
Microsoft Access has a great function called Office Links. With a press of a 
button (Tools> Office Links> Analyse it with Excel) you can automatically 
create an Excel file with the information from any table, report or query. 

 
! VIP Technical Tip - Do you use Lotus Notes? 
When you open a .wk1 or .wk3 file in Excel, Excel applies the formatting in the 
associated .fmt, .fm3, or .all file. If you save a Lotus 1-2-3 file in Excel 
format, Excel saves the spreadsheet data and formatting in a single workbook file. 
 
 
Figure 2.2 An example from my database of how you can create any field you want in 
Excel (column of information) then sort by it. 
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More Advanced Design 
The software you need for design is predicated upon what you want to send. 
 
Plain Text And Simple HTML (Rich Text Format) 
Outlook, Outlook Express, Word, Notepad, Lotus for Plain text or simple formatting 
(later versions). 
 
If you�re going to do a plain text or a simple html email, you really only need your 
normal email software to both design and then send the emails. 
 

Figure 2.3 This is what Outlook will allow you to format. That�s it!!!! 

 
 
 
FrontPage or Dreamweaver for the more advanced design.  
 
We suggest when you use tables, insert graphics, use background shading or want to do 
surveys � you really should use the proper web design software like the two most popular 
ones �Microsoft FrontPage or Macromedia Dreamweaver.  You wouldn�t wash the dishes 
with a toothbrush would you? Use proper tools for the right job to save yourself simply 
hours upon hours of frustration. Most hair pulling is avoided � I promise. Don�t be afraid 
of using FrontPage, it�s easy to learn if you know Word. Dreamweaver is a bit different 
(different terminology, different toolbars) but again if you can easily pick up new 
software based on your existing knowledge � it won�t be difficult.  
 
Do what I did � I went to a large bookstore, grabbed all the How-To books on 
(Dreamweaver, FrontPage � what ever you�ll be using). They�re different � some are 
pictorial and very visual, some are quite heavy on the text. Sit, spend an hour browsing 
and pick the best book for your style of learning. Then, later with the book beside you, a 
willingness to learn, and some free time � have a play and start teaching yourself. You�ll 
learn what you need to know. 
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Debbie Mayo-Smith Profile 
Managing Director SuccessIS 
�A native New Yorker, Debbie is a world leading authority on database, email and 
Internet marketing and a top rating presenter�. From New York City to Borneo, Sydney 
to Perth, Debbie wow�s her audiences with her easy to follow, non-hyped approach, 
visual presentations and clever ideas and strategies on incorporating database marketing 
with email and the Internet for business development, sales and customer service. 
Debbie is in demand as a keynote speaker, trainer and consultant with a client list that 
reads like a who's who of International business.   

Need a Speaker? Leading International CRM, Marketing and 
Internet Expert" 
Want an inspiring, motivating yet practical �How-To� message on improving sales, 
marketing, office efficiency, business development and customer service?  

Do your attendees want to know how to improve their website results (need I ask)?Than 
you must have Debbie help with your next conference or with training. 
 

Individually crafted presentations 
No two presentations are ever the same. I�ll spend time reviewing websites of attendees 
and customise it to them. I�ll also speak in depth to your IT people to learn in detail about 
what software the majority of the attendees use for their client information and also what 
marketing, business development and services they�re likely to do. Then I�ll weave this 
knowledge into my presentation to enhance what they�re doing now and add in new 
ideas, tips and tricks that they can take on board. 

The content is motivational and practical at the same time. I use everyday language 
(nothing technical) with visual examples and "what's in it for me" from the attendees 
point of view.  

Free Pre- Conference Online Survey 
I will conduct an online survey of all those invited or all the 
attendees before the seminar to structure my presentation 
completely at their level.  

n 
I can add any questions you like and I�ll prepare an Executive 
summary of all responses and I�ll also give you all their answers o
an Excel Spreadsheet.  

Free Continuing Education 
Each participant will receive a free subscription (if they like) to my monthly online 
marketing and business development tip newsletter so the learning continues indefinitely! 
 
Profile 
ASM designation National Speakers Association. Honours Bachelor of Science Degree in 
Economics and Geography � Southern Connecticut University USA. 
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Michael F Barnett: Chief Executive: Auckland Chamber of Commerce:  
"Our star presenter was Debbie Mayo-Smith, our highest rating speaker� 

Leisa Donlan: President Australia Society of Association Executives 
CEO Australasian Rotational Moulding Association 
Just thought I would send through a very quick email.  Following your advice we've 
updated and changed our web site www.rotationalmoulding.com and we are now listed 
NUMBER ONE on google for "rotational moulding" and NUMBER TWO for rotational 
moulders.  

We are absolutely wrapped about the results.  The site can probably still use some work, 
but what an improvement, your seminar changed our whole philosophy.   

Jeff Tubbenhauer CFP 
Just a short note to say thanks for presenting at the AMP conference where you gave us a 
talk on emailing.  I bought your book, read all of it and have put your email know how 
together for my own use. My first email August 02 produced me around $1,800 of fees. 
Thanks! 
 
Ralph Penning  
Executive Trustee Independent Business Foundation  (Debbie�s Newsletter) 
"You are a real winner.Your Successful Internet Strategies newsletter receives the highest 
rating among the promotional mailings reaching my screen. Why? Because you don't 
mind giving away handy tips that others guard like trade secrets. I constantly mention 
you as a role model, and won't mind your quoting me on it."  
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Description of Books 
Want To Build A More Profitable Business?  
Than You Must Have This 3 Book Trilogy: 
Successful Email Marketing 
Your Complete �How-To� Guide 
Become a superb marketer of your business; then apply the strategies to 
email. S.E.M. continues with detailed instructions on how to write, 
design and send emails that get results for you. You�ll learn tested tricks, 
tips, pitfalls, solutions, case studies and examples from New Zealand, 
Australia and around the world. Furthermore everything you�ll learn can 
be related to websites and print communication too! 
 
Heather Douglas: Managing Director Homebizbuzz: "What a great 
publication, worth many times its weight in gold! Few books show you 
how to make as much difference to your bottom line, with so little 
expenditure, as this one. It's a simple, foolproof guide to getting a cost-
effective email marketing strategy off the ground, and leveraging every 
bit of worth from it for years to come! There's so much value in here - I 
don't know how any home business these days can operate without 
implementing every one of your ideas". 
 

Version 
 
Print 

Price 
 
$40.00 

Superb Tips And Tricks for Managing Your Customer Information 
A veritable treasure trove of tips and tricks. This gem of a book will set 
you on a minimum effort course to building your own goldmine � for 
now and the future. Whether starting from scratch, enhancing your 
existing database or you just want to know inside expert tips, this book 
will prove invaluable in saving you time, anguish and helping you enact 
marketing campaigns at the push of a button.  
 
In plain language and with great screen shots, Debbie will show you how 
to take your customer information and work with it in Excel. You�ll slash 
hours and hours off your workload learning how you can automatically 
clean up data, fill in the holes, add in your email contacts, fix keypunch 
errors and finally create targeted mailing lists in 2 minutes flat. 
 

 
Print 

 
$40.00 

Exactly How To Create Your Own Professional Online Newsletters 
Do you want to take your online communications from average to 
spectacular? Do you want to send a great professional looking online 
newsletter to your clients and prospects? You don't need to go to 
expensive advertising or web development agencies or the budget of the 
large corporations.  

 All you need is good to intermediate computer skills and this great new 
fully illustrated Step - by - Step 'How-To' Manual. 

 
Print 

 
$25.00 
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                                        Book Order Form 
 
Successful Internet Strategies            Please Tic for Order 
 Version Price $ 
Successful Email Marketing � Your Complete �How-
To� Guide 
 

Print $40.00  

Superb Tricks And Tips for Managing Your Customer 
Information 
 

Print $40.00  

Professional Online Newsletters and Emails Exactly 
How To Create Your Own  

Print $25.00  

 
Special � Purchase All Three!           

% Save $15.00! 

% FREE! Debbie will airmailr the print versions 
of all three for free 

 

  
$90.00 

 

Total Order: please tally 
 

 

Your Details:   
 
Name _________________________________________________________________________ 
 
Company_________________________________________________________________ 
 
Address _________________________________________________________________ 
 
_______________________________________________________________________ 
 
Email ______________________________________ Ph.__________________________  
 
Payment Details:    & Cash     & Cheque      & Credit Card 
 
Please bill my credit card for $  
Credit Card Type          &Visa              & MasterCard             & Diners           & Amex 
 
Card No#.___________________________________________________________________ 
 
Name on card________________________________________Exp. date______________ 
 
Signature__________________________________________________________________ 

 

 


